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SUMMARY

Glioblastoma (GBM) cells invade the brain by following linear structures like
blood vessel walls and white matter tracts by using specific motility modes. In
this protocol, we describe two micropatterning techniques allowing recapitula-
tion of these linear tracks in vitro: micro-contact printing and deep UV photoli-
thography. We also detail how to maintain, transfect, and prepare human glioma
propagating cells (hGPCs) for migration assays on linear tracks, followed by im-
age acquisition and analysis, to measure key parameters of their motility.
For complete details on the use and execution of this protocol, please refer to
Monzo et al. (2016) and Monzo et al. (2021a).

BEFORE YOU BEGIN

Micropatterning techniques allow ‘printing’ matrix proteins on the surface of imaging dishes or cov-

erslips to restrain cell adhesion onto specific patterns (Chen et al., 1997, 1998; Craighead et al.,

2001; Singhvi et al., 1994). Several techniques have been used for micropatterning surfaces,

including micro-contact printing or deep UV photolithography (Azioune et al., 2010; Csucs et al.,

2003; Fink et al., 2007). When the technique of deep UV photolithography is used, the surface

(i.e., the coverslip) is first ‘passivated’ with PLL-g-PEG and the pattern is then formed by burning

the PLL-g-PEG through a photomask. The patterned area can then be coated with the molecule

of interest. Photomasks can be obtained through various sources (Monzo et al., 2021b) (Monzo

et al., 2021a).

When the microcontact printing technique is used, an elastomeric stamp (made of Polydimethyl-

siloxane, PDMS), with patterned relief structures, is first ‘inked’ with the molecule of interest such

as laminin or fibronectin. The pattern is then printed onto the surface of an imaging dish by press-

ing the stamp onto the dish. The surface of the dish is then passivated to prevent cell attachment

outside of the patterned area. To prepare the PDMS stamp, a silicon wafer with the negative fea-

tures must be made using photolithography or laser engraving. This wafer will serve as a master

mold from which positive PDMS replica will be obtained. Such wafers can be obtained from

various commercial sources (Fink et al., 2007; Théry and Piel, 2009). Stamps are prepared by

curing the PDMS onto the silicon wafer (Figure 1A) (Xia and Whitesides, 1998). To allow the un-

molding of the PDMS, it is important to prevent its adsorption onto the wafer by silanizing the sil-

icon wafer before its first use (Seed, 2000). After silanization, silicon wafers can be used multiple

times without the need to be silanized again. Once cured, the molded PDMS can be kept at room

temperature (20�C–25�C) for months.
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Silanization of the silicon wafer

Timing: 10 min + overnight incubation (12–20 h)

Note: Silane vapors are toxic and highly flammable. The steps involving silane should be con-

ducted in a chemical fume hood.

1. Place the silicon wafer inside a plastic petri dish with the cap of an Eppendorf tube next to it.

2. Place the petri dish containing the silicon wafer and the cap inside a desiccator.

3. Place the desiccator under a chemical fume hood.

4. Add the compressed inert gas (such as nitrogen) in a beaker sealed with parafilm (keep adding the

gas while aspirating with the syringe) and aspirate 100–200 mL of gas.

Figure 1. Microcontact printing

(A) Preparation of PDMS (soft lithography). (a) elastomer base and cross-linking agent are mixed on a weighing board at 10:1 ratio. (b) PDMS is degassed

under vacuum for 30 min. (c) PDMS is poured on the silicon wafer. (d) PDMS is degassed under vacuum for 30 min. (e) PDMS is cured for 2 h at 70�C. (f)
PDMS is unmolded from the silicon wafer with a scalpel.

(B) Details of the various steps involved in microcontact printing. (a) PDMS is unmolded from the silicon wafer. (b) Stamps are cut in 1 cm2 squares and

plasma-cleaned for 3 min. (c) Stamps are coated with laminin for 30 min. (d) stamp is blown with an air-gun to remove the excess of laminin. (e) Stamp is

leant and removed from the substrate to perform microcontact printing.

(C) Main steps of microcontact printing: (a) The mixture of elastomer base and cross-linking agent (PDMS 10:1, previously degased) is poured on the

silicon wafer (which has been silanized). (b) The PDMS on the silicon wafer is kept in a vacuum desiccator to remove all bubbles. (c) After curing, the

PDMS is unmolded and cut into small stamps. The inset shows the griddedmicropattern used in (Monzo et al., 2021a). (d) Stamps are plasma cleaned. (e)

After incubation with laminin, the stamps are gently dried with an air-gun. (f) PDMS stamps are gently pressed onto the surface of the imaging dish to

print laminin micropatterns (see inset). Scale bars are 100 mm.
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5. Punch the rubber cap of the hexamethyldisilazane bottle with the needle, turn the bottle upside

down, inject the gas and withdraw 100–200 mL of hexamethyldisilazane.

6. Transfer hexamethyldisilazane in the cap of the Eppendorf tube, close the desiccator, apply vac-

uum for 1 h, leave the desiccator sealed, and let the silane be deposited on the surface of the sil-

icon wafer overnight (12 h–20 h).

7. The wafer is then transferred to a glass petri dish and is ready to use.

CRITICAL: Never open the silane solution vial. The solution is withdrawn from the vial by

inserting a syringe needle through the rubber cap and exchanging an equivalent quantity

of inert gas. This is to avoid oxidation that would prevent silane from binding to the silicone

(Seed, 2000).

Preparation of PDMS (Sylgard 184 silicone elastomer kit)

Timing: 3 h

The PDMS is prepared by mixing the elastomer base and the cross-linking agent in a ratio 10:1 (Syl-

gard 184 silicone elastomer kit).

8. In a weighing board or a 10-cm dish, pour 10 g of the elastomer base (Sylgard 184 silicone elas-

tomer kit) and add 1 g of the cross-linking agent using a plastic Pasteur pipette (Figure 1A).

9. Stir vigorously the mixture using the same pipette.

10. Degas the mixture into a vacuum desiccator for 30 min or until all the bubbles have disappeared

(Figure 1A).

11. Pour gently all the solution onto the wafer and degas again for 30 min or until all the bubbles

have disappeared (Figures 1A and 1C-a-b).

12. Verify that no more bubbles are present and place the wafer in an oven at 70�C to cure for 2 h.

13. Unmold the PDMS by cutting around the edge with a scalpel and place it in a 15-cm plate with

the features facing up (Figures 1A and 1B).

Note: PDMS can be stored for months at room temperature (20�C–25�C) protected from dust.

CRITICAL: Make sure no air bubbles are present when placing the wafer and PDMS to

cure.

Coating of untreated petri dishes

Timing: 45 min

For electroporation and migration assays, human Glioma Propagating Cells (hGPC) are cultured as

monolayers on laminin-coated plates for 3–5 days. Laminin adsorbs better on untreated plastics like

bacterial plates. We usually coat 6-cm bacterial plates to culture our hGPC and 35-mm bacterial

plates to recover the cells after electroporation.

14. Under a biosafety cabinet, add 2 mL of DPBS in a 6-cm bacterial plate or 1 mL to a 35-mm bac-

terial plate.

15. Add laminin in the DPBS in order to obtain a 10 mg/mL final laminin concentration. The amount

of laminin depends on the concentration of the stock (e.g., dilute 17.2 mL of laminin for a

1.16 mg/mL stock solution in 2 mL).

16. Rock the plate on a rocker at room temperature (20�C–25�C) for 30 min to ensure a homoge-

neous coating.

17. Aspire the laminin solution and wash 2 times with 2 mL DPBS.
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18. Replace the DPBS with 2–4 mL of GSC medium complemented with growth factor mix. The dish

is now ready for cell seeding.

CRITICAL: To ensure an optimal coating of laminin, the dishes must not be tissue culture

treated. Rocking allows the solution to cover the dish entirely. Due to the hydrophobicity

of the bacterial plate, 2 mL of DPBS only will not spread as a flat layer over the surface.

However, upon laminin adsorption, the 2 mL is enough to cover the surface of a 6-cm dish.

Acid wash coverslips

Timing: 2 h

For deep UV photolithography, we wash our coverslips with nitric acid to remove any traces of oil

that could impair the coating or the imaging.

Note: The steps involving nitric acid should be conducted in a chemical fume hood, with the

appropriate PPE.

19. Fill a coverglass rack with the desired number of round coverslips and transfer it into a beaker.

20. Under a chemical fume hood add 20% Nitric acid to cover all the coverslips.

21. Cover the beaker with aluminum foil and incubate for 2 h.

22. Remove the rack with a tweezer, recycle back the acid in the acid bottle, put back the rack in the

empty beaker, and rinse it 3 times with ddH2O.

23. Replace the ddH2O with a solution of ethanol at 70%, and keep covered to avoid evaporation.

Note: The coverslips can be stored in ethanol at room temperature (20�C–25�C) for several
months.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins

3-(trimethoxysilyl)-propyl methacrylate Merck Cat#M6514-25ML

Albumin from Bovine Serum (BSA),
Alexa FluorTM 647 conjugate

Thermo Fisher Scientific Cat#A34785

B-27� Supplement Thermo Fisher Scientific Cat#17504044

Bovine serum albumin (BSA) VWR Cat#1000-70-500G

DMEM/F-12, GlutaMAX� Supplement Thermo Fisher Scientific Cat#31331093

Heparin sodium salt from porcine
intestinal mucosa

Sigma-Aldrich Cat#H3149-10KU

HEPES Euroclone Cat#ECM0180L

Hexamethyldisilazane Sigma-Aldrich Cat#440191

Laminin Mouse Protein, Natural Thermo Fisher Scientific Cat#23017015

Nitric Acid Merck Cat#84378-1L

Non-essential amino acid Biowest Cat#X-0557

Penicillin/streptomycin Euroclone Cat#ECB3001

PLL-PEG (PLL(20)-g[3.5]- PEG(2) SuSoS Cat#PLL(20)-g[3.5]- PEG(2)

Pluronic� F-127 Sigma-Aldrich Cat#P2443-250G

QIAfilter Plasmid Maxi Kit QIAGEN Cat#19743

Recombinant Human EGF PeproTech Cat#AF-100-15

Recombinant Human
FGF-basic (154 a.a.)

PeproTech Cat#100-18B

(Continued on next page)
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MATERIALS AND EQUIPMENT

EGF and FGF solutions: FGF and EGF powders (stored at �80�C) are centrifuged at 16,000 3 g for

30 s and reconstituted in sterile water to a solution at 1 mg/mL as indicated by the manufacturer.

After reconstitution, the solution is further diluted in a sterile solution of BSA (1 mg/mL in DPBS)

to a final concentration of 100 mg/mL.

Note: FGF and EGF are stored in 20 mL aliquots at �80�C for < 1 year.

GSCmedium: DMEM/F-12 containing glutamax is supplemented with sodium pyruvate, non-essen-

tial amino acid, penicillin/streptomycin.

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Sylgard 184 silicone elastomer kit Dow Corning Cat#1064291

Sodium pyruvate Biowest Cat#L0642

Tris ultrapure Euroclone Cat#EMR045001

Trypsin-EDTA 13 in PBS Euroclone Cat#ECB3052D

Deposited data

Programs for speed and
persistence measurements

(Gorelik and Gautreau, 2014) https://www.nature.com/
articles/nprot.2014.131#Sec28

Experimental models: Cell lines

NNI-21 Carol Tang, National
Neuroscience Institute (NNI)

N/A

NNI-24 Carol Tang, National
Neuroscience Institute (NNI)

N/A

NNI-11 Carol Tang, National
Neuroscience Institute (NNI)

N/A

Software and algorithms

ImageJ (Schindelin et al., 2012) https://imagej.nih.gov/ij/
download.html

Graph Pad Prism 9.0 GraphPad https://www.graphpad.com/
scientific-software/prism/

Leica Application Suite (LAS) Leica Microsystems LAS

Microsoft Excel Microsoft N/A

Other

Chrome mask PHOTOMASK PORTAL https://www.photomaskportal.com

Engraved silicon wafer Mechanobiology Institute MBI#395

Fluorescence lamp Leica Microsystems Kubler codix

13 Neon� Transfection System 100 mL kit Thermo Fisher Scientific Cat#MPK10096

Neon Transfection System Thermo Fisher Scientific Cat#MPK5000

Glass bottom dishes, 35 mm Mattek Cat#P35G-1.5-20-C

Greiner dishes, petri dish,
35 3 10 mm, triple vented

Merck Cat#P5112-740EA

Greiner dishes petri dish,
60 3 15 mm, vented (6 vents)

Merck Cat#P5237-600EA

Microscope air pump Okolab OKO-AP

Microscope CO2 unit Okolab DGTCO2BX

Microscope heating unit Okolab H201-T

Microscope stage controller Okolab MW tango

TIRF microscope Leica Microsystems Leica AM TIRF MC

Plasma Cleaner Harrick Plasma PDC-32G-2 (230V)

Porcelain coverglass rack Thomas scientific N/A

Precision cover glasses thickness
No. 1.5H (tol. G 5 mm) for high
performance microscopes, 24 mm Ø

Marienfeld Cat#117640

UVO cleaner Jelight Company Inc. 342-220
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Note: This medium is stored at 4�C for 1–2 months.

GSC-BSA medium: DMEM/F-12 containing glutamax is supplemented with sodium pyruvate, non-

essential amino acid, penicillin/streptomycin, and 25 g of BSA. The bottle of medium is incubated for

30 min at 37�C until BSA dissolves. The medium is then filtered (0.2 mm filter), aliquoted in 40 mL

aliquots, which can be stored at �20�C for < 1 year.

503 Grow factor mix solution: Add 20 mL EGF (100 mg/mL), 20 mL FGF (100 mg/mL) and 100 mL hep-

arin (5mg/mL) to 2mL B27 supplement, mix gently by pipetting up and downwith a 5-mL serological

pipette.

Note: This mix is stored at 4�C for 2 weeks maximum. Themix is added directly to the cells (80 mL

of mix per 4 mL GSC medium for a 6-cm dish) to obtain GSC medium containing a final concen-

tration of B27 supplement (13), bFGF (20 ng/mL), EGF (20 ng/mL), and heparin (5 mg/mL).

Note: 2 mL aliquots of B27 supplement are stored at �20�C until the expiration date.

Laminin stock solution: Laminin is provided at a concentration close to 1 mg/mL (exact concentra-

tion of the lot is indicated on the vial). Laminin is thawed overnight (12 h–20 h) at 4�C, aliquoted, and
stored at 4�C.

Note: the laminin aliquots can be stored at 4�C for < 1 month. Once thawed, we never freeze

back the laminin.

Pluronic solution: Add 2 g of pluronic F-127 to 1 L of ddH2O. To dissolve pluronic F-127, incubate

the solution overnight (12–20 h) at 4�C, then filter (0.45 mm filter).

Note: The solution can be stored at room temperature (20�C–25�C) for several years.

PLL-g-PEG stock solution: a 1 mg/mL stock solution is prepared by adding 20 mL of 10 mM HEPES

to 20 mg of PLL-g-PEG.

Reagent Final concentration Total quantity

DMEM/F-12-glutamax (13) 13 500 mL

Sodium pyruvate (100 mM) 1 mM 5 mL

Non-essential amino acid (1003) 13 5 mL

Penicillin/streptomycin (1003) 13 5 mL

Reagent Final concentration Total quantity

DMEM/F-12-glutamax (13) n/a 500 mL

Sodium pyruvate (100 mM) 1 mM 5 mL

Non-essential amino acid (1003) 13 5 mL

Penicillin/streptomycin (1003) 13 5 mL

BSA (Powder) 5% 25 g

503 grow factor mix Final concentration Total quantity

B27 supplement (503) 503 2 mL

EGF (100 mg/mL) 1 mg/mL 20 mL

FGF (100 mg/mL) 1 mg/mL 20 mL

Heparin (5 mg/mL) 250 mg/mL 100 mL
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Note: The solution is filtered (0.2 mm filter pore), aliquoted, and stored at 4�C for < 1 year.

PLL-g-PEG working solution: a 0.1 mg/mL working solution is prepared by adding 36 mL of 10 mM

HEPES to 4 mL of PLL-g-PEG stock solution.

Note: The solution can be stored at 4�C for < 1 year.

Time-lapse microscopy: Total Internal Reflection Fluorescence (TIRF) microscope (Leica) equipped

with temperature, CO2 control, a HCX PL APO 10 3 /1.47NA oil immersion objective. The micro-

scope is driven with LAS software (Leica).

Note: any microscope equipped with temperature, CO2 control, 103 phase objective, and an

automated stage can be used.

STEP-BY-STEP METHOD DETAILS

Substrate preparation: silanization, micro-contact printing, passivation, and deep UV

photolithography

Timing: 2 h for step 1

Timing: 2 h for step 2

Timing: 4 h for step 3

The micropatterns can be obtained by microcontact printing: PDMS stamps are covered with a so-

lution of laminin. Then, the excess of laminin solution is removed, and the stamps are carefully

pressed on the surface of the imaging dish for imprinting the desired features on it (Figures 1B

and 1C) (Fink et al., 2007; Xia and Whitesides, 1998). The rest of the surface is then passivated to

prevent the cells from attaching outside of the stamped features. For routine migration assays, mi-

cropatterns are made on 35-mm plastic bacterial plates. For Total Internal Reflection Fluorescence

(TIRF) or confocal imaging, micropatterns are made on glass-bottom dishes that are first silanized to

help the laminin to adsorb better to the glass. The passivation on plastic is performed with pluronic

solution while the passivation on glass is performed with PLL-g-PEG working solution. A good alter-

native to the microcontact printing on glass is the technique of deep UV photolithography that is

also described here (Figure 2) (Azioune et al., 2009, 2010). Deep UV photolithography consists of

first coating coverslips with PLL-g-PEG and then burning it with the desired features using a photo-

mask and deep UV. The regions that have been burned can be subsequently coated with the desired

substrate (in our case, laminin, Figure 2A). Deep UV photolithography is easier than themicrocontact

printing on glass and less prone to variations due to the experimenter. It is preferable when protein

concentration has to be finely tuned, for substrate concentration comparison for example. However,

since laminin adsorbs much better on plastic, micro-contact printing on plastic is preferred for long-

term cultures or for large micropatterns where many cells need to adhere (Monzo et al., 2016). In this

case, cells can stay attached to the patterns for many days whereas on glass, high-density cultures

can rip off the laminin substrates rapidly.

Note: Sterility is not needed to perform the steps 1–3. However, at the very end of steps 2 and

3, dishes are transferred under a biosafety cabinet to be rinsed with sterile PBS and filled with

culture medium under sterile conditions.

1. Silanization of glass bottom dishes:

a. Incubate the glass-bottom dishes in silane solution (1.2 mL of 3-(trimethoxysilyl)-propyl meth-

acrylate diluted in 2 mL methanol per dish) for 1 h at room temperature (20�C–25�C).
b. Remove silane solution and rinse three times with methanol for 5 min each time on a rocker.
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c. Remove the methanol and air-dry the dishes under the chemical hood to evaporate the left-

over methanol.

d. Proceed with the stamping procedure as indicated in step 2.

CRITICAL: Silane vapors are toxic and highly flammable. The steps involving silane should

be conducted in a chemical fume hood. Once silanized, the glass bottom dishes can be

kept overnight (12–20 h), at room temperature (20�C–25�C), protected from dust, before

micro-contact printing.

2. Micro-contact printing and passivation:

a. Using a scalpel, cut out the desired features (stamps are around 1 cm2) and place them in a

small culture dish (the features must be facing up).

b. Remove the lid of the dish to expose the stamps and place it in the plasma cleaner. Start the

vacuum pump, switch ON the plasma cleaner for 3 min (Figures 1B and 1C-d). This step makes

the surface of the PDMS stamps hydrophilic and facilitates the coating of the stamps.

Figure 2. Deep-UV photolithography

(A) Principles of deep-UV lithography. PEGylated coverslips are placed on the chrome mask, bubbles are removed

and the PLL-g-PEG is burned through the micropatterns drawn on the photomask, by deep UV, for 10 min. The

coverslips are then mounted either on an imaging chamber or on a 35-mm dish with a hole, and coated with laminin at

37�C for 1 h.

(B) Main steps of deep-UV lithography: (a) acid washed and air-dried coverslips are placed in a coverslip holder for

plasma cleaning. (b) plasma cleaned coverslips are coated with PEG-g-PLL. (c) PEGylated coverslips are placed onto a

drop of milliQ water covering the micropatterns on the chrome mask. (d) The chrome mask is placed in the deep-UV

machine coverslips facing down. (e) The coverslips are lifted from the chrome mask using milliQ water. (f) Micropat-

terned coverslips are mounted in magnetic imaging chambers.
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c. Add 20 mL of laminin solution (50 mg/mL in DPBS) on top of the stamps, and incubate at room

temperature (20�C–25�C) for 30 min (Figure 1B).

Note: Fluorescent BSA can be added to the laminin solution in order to visualize the stamped

area at the microscope. We usually mix BSA-Cy5 at a final concentration of 7 mg/mL with our

laminin solution (Figure 1C-f) (Monzo et al., 2021a).

d. Using a tweezer, hold the stamp, and air-blow dry all the laminin (Figures 1B and 1C-e), turn

the stamp upside down and press it gently onto the imaging dish.

CRITICAL: No micro-droplets must be left on the edges of the stamp. Due to capillarity,

they might flow in between the features of the stamp. However, an excessive air-blow

dry of the stamp detaches the coating. Therefore, we recommend leaning the side of

the stamp onto a kimwipe as a first step: this removes the majority of the coating solution.

Then air-blow dry the stamp.

e. After 1–2 min remove the stamp from the imaging dish in a single motion.

CRITICAL: The stamp must not be shaken while leaning. To remove it, we use two twee-

zers. This helps to leverage the stamp and avoids smearing the pattern. We never re-use

the stamps and each stamp is meant for 1 dish.

f. In caseof plastic dishes, add2mLof pluronic solutionperdish. In caseof glass-bottomdishes, add

300 mL of PLL-g-PEG working solution per dish. Incubate 1 h at room temperature (20�C–25�C).
g. Transfer the dishes under a biosafety cabinet, aspirate the solutions of pluronic and PLL-g-PEG

and replace with 2 mL of sterile DPBS, rinse 5 times with dPBS and replace with 2 mL GSC me-

dium and 40 mL of growth factor mix. The dishes are now ready for cell seeding.

Note: We never store the dishes with pluronic, PLL-g-PEG or DPBS, we recommend to store

them in GSCmedium at 37�C and to seed the cells within 24 hours (preferably the same day of

micro-contact printing).

3. Deep UV photolithography.

a. Pick up the coverslips from the ethanol solution and dry them one by one with an air-gun.

Transfer them to a clean rack (Figure 2B-a).

b. Place the rack containing the dried coverslips in a plasma cleaner, start the vacuum pump,

switch ON the plasma cleaner for 3 min.

c. Drop 100 mL PLL-g-PEG working solution (100 mg/mL) on the bottom of a petri dish previously

covered with a layer of parafilm (Figure 2B-b).

d. Flip the coverslips onto the drops and incubate 1 h at room temperature (20�C–25�C).
e. Using a tweezer, rinse the coverslips in a beaker containing milliQ water, and let them dry on a

paper towel, the PEG-PLL facing up.

f. Clean the photomask with isopropanol and carefully dry it with a kimwipe or airflow.

g. Place the photomask under deep UV for 5 min (golden side facing up) to make it more hydro-

philic.

h. Place the photomask (golden side facing up) onto the bench, drop 4 mL of milliQ water onto

the desired pattern and flip the coverslip on the drop. The PLL-g -PEGmust be in contact with

the mask (Figure 2B-c).

i. Remove all the bubbles between the mask and the coverslip by gently pressing on the cover-

slip with the tip of the tweezer.

CRITICAL: Always wear protective nitrile gloves when manipulating the mask to avoid

leaving fingerprints. Make sure to remove the bubbles since they interfere with the
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mask design. Some user might find it easier to remove the bubbles by pressing gently the

cover slip with the tip of the finger. If using a metallic tweezer, be careful to not touch the

patterns of the mask with the tweezer as it may scratch easily. If possible use a plastic

tweezer.

j. Place the mask (golden side facing down) under deep UV for 10 min (Figures 2A and 2B-d).

k. Place the mask, face-up, on a paper towel, spray milliQ water onto the coverslips and let them

detach (do not force them to detach to avoid smearing the PLL-g-PEG, Figure 2B-e).

l. Rinse the coverslips in milliQ water and transfer them to an imaging chamber.

Note: The imaging chamber can be a magnetic imaging chamber (Figure 2B-f) or can be

fabricated by mounting the coverslip onto a 35 mm petri dish with a hole in the middle of

the bottom surface. The mounting can be done with biocompatible glue such as dental glue.

m. Transfer the dishes under a biosafety cabinet, coat the coverslip with 10 mg/mL laminin diluted

in sterile DPBS, incubate at 37�C for at least one hour.

n. Rinse 2 times with DPBS and replace with 2 mL GSC medium and 40 mL of growth factor mix.

The dishes are now ready for cell seeding.

Note: Before coating (stepm)micropatterned-coverslips can be stored at 4�C, face-up, in a dish
sealed with parafilm for <1 week. After coating, we never store the dishes with DPBS, we recom-

mend storing them in GSC medium at 37�C and seeding the cells within the next 24 hours.

Maintenance of human glioma propagating cells (hGPCs)

Timing: 30 min, every 5 days

Patient-derived glioblastoma propagating cells are obtained from patient tumor samples and are

not commercially available. Methods to initiate and propagate such lines from tumor tissues are

well established (Gritti et al., 1996; Stringer et al., 2019). NNI-11, NNI-21 and NNI-24 cell lines

analyzed in (Monzo et al., 2021a) were provided by the laboratory of Carol Tang (Singapore) (Chong

et al., 2016; Tan et al., 2019). The maintenance and expansion of these cells are described here.

hGPCs are cultured in 6-cm dishes as tumor-spheres (Figure 3A). Every 5 days, spheres are triturated

and passaged according to their growth rate (Figure 3B). Before imaging or transfecting, cells are

triturated and passaged on plates coated with laminin (Figure 3C).

Note: The following steps should be conducted under a level 2 biosafety cabinet.

CRITICAL: hGPCs should be dissociated into single cells to ensure proper growth

(Figure 3B).

4. Evaluate the density of the tumor-spheres at the microscope (see Figure 3A) and transfer the con-

tent of the dish into a 15-mL tube.

5. Centrifuge the sphere suspension at 200 3 g for 5 min at room temperature (20�C–25�C).
6. Aspirate the supernatant, add 1 mL of GSC medium.

7. Triturate by pipetting the suspension up and down 100 times with a P1000 pipetman set at

800 mL. After trituration, no sphere should remain (Figure 3B).

Note: If a large number of spheres remain after trituration, we recommend further triturating

by pipetting 20–30 times. Passage number recommended: 10–15 times.

8. In function of the cell growth rate, transfer between 1/20 to 1/3 of the cell suspension volume to a

new 6-cm culture dish containing 4mL of GSCmedium and 80 mL of grow factor mix. Cells are also
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seeded on laminin-coated plates (Figure 3C) for transfection and/or migration assay (see ‘before

you begin’ section for laminin coating).

9. After 5 days, passage the cells again.

hGPC transfection by electroporation

Timing: 45 min

hGPCs are detached from their plate and counted. One to two million cells are electroporated with

10 mg of DNA using the Neon� Transfection System 100 mL Kit and subsequently re-plated on a lam-

inin-coated dish (Figures 3D–3G). For transfection, we use purified DNA (QIAfilter Plasmid Maxi Kit -

Qiagen) adjusted at a concentration of 1 mg/mL in milliQ water.

Note: The following steps should be conducted under a level 2 biosafety cabinet.

10. Aspirate the medium and rinse the cells with DPBS.

11. Add 0.5 mL of trypsin/EDTA for a 6-cm dish and incubate for 2 min at 37�C.

Note: incubation time may vary according to the cell line. To avoid any toxicity effect due to

over-exposure to trypsin, we advise monitoring cell detachment under the microscope.

Figure 3. hGPC maintenance and transfection

(A) hGPC tumor-spheres as seen under the microscope (103 objective) after 5 days in culture.

(B) hGPCs after trituration (no spheres are present).

(C) hGPCs as a confluent monolayer grown on a laminin-coated dish.

(D) Neon pipette and Neon tip.

(E) Neon Electroporator setup.

(F and G) hGPCS transfected with GFP control vector 24 h after electroporation (GFP channel and phase contrast).

Scale bars are 100 mm.
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12. Inactivate the trypsin with 3.5 mL of GSC-BSA medium and transfer the cell suspension in a

15-mL tube.

CRITICAL: To neutralize trypsin, a serum-containing medium must be avoided to prevent

hGPC differentiation. We use BSA to neutralize the trypsin but other means such as trypsin

inhibitor could be used.

13. Transfer 10 mL of cell suspension and count the cells in a cell counting chamber (or the volume

necessary for the available cell counting machine).

14. Centrifuge for 5 min at 200 3 g.

15. Aspirate the supernatant, add 4mL of DPBS to the cell pellet, and centrifuge for another 5 min at

200 3 g.

16. Aspirate the supernatant and re-suspend the cell pellet with buffer R (that is contained in Neon�
Transfection System 100 mL Kit) in order to obtain 1–2 3 106 cells / 100 mL.

17. Place the cuvette in the Neon electroporator and add 3.5 mL of buffer E2 (that is contained in

Neon� Transfection System 100 mL Kit).

CRITICAL: Make sure the cuvette ‘‘clicks’’ inside the slot in the Neon electroporator. Click-

ingmeans that all the electrical pads that provide the voltage pulsemake contact correctly.

Avoid wetting the electrical pads located between the cuvette and the Neon

electroporator.

18. Add 12 mL of DNA to a 1.5 mL sterile Eppendorf tube, add 120 mL of the cell suspension in buffer

R. The volume of buffer R has to be 10 times greater than the volume of DNA. Mix gently up and

down the cells with the DNA. Avoid bubble formation as much as possible as it will prevent the

conduction of the electroporating stimulus.

19. Set the following parameters on the Neon electroporator. Voltage: 1,600 V, pulse duration:

20 ms, number of cycles: 1.

Note: The optimization of the electroporator parameters might vary according to the cell line.

We recommend a dedicated experiment to find the parameters that maximize transfection ef-

ficiency and cell viability. These settings correspond to the ones we used for the hGPC line

NNI-21 (Monzo et al., 2021a).

20. With the Neon pipette pick up the tip for electroporation (Figure 3D).

Note:Wemix 120 mL buffer R + 12 mL of DNA to have an extra volume. This is to avoid bubble

formation when we pipet the solution with the 100 mL-neon tip.

21. Take 100 mL of cell suspension - DNA mixture and insert the Neon pipette along with the tip in

the cuvette.

22. Hit ‘‘Run’’ on the Neon electroporator. The machine indicates if the electroporation occurred or

if there is a connection problem. Also, at the time of the choc, bubbles can be observed at the

level of the resistance.

23. Transfer the electroporated cells directly to the 35-mm bacterial plate that was previously

coated with laminin.

Note: If cells are well adherent on the dish, it is advisable to change the medium after 6/8

hours from transfection. This helps to improve cell viability.

24. The day after, check the cells and change the medium. Cells can also be trypsinized and trans-

ferred to another dish. Cells can start expressing the construct within the next 6–8 h (Figure 3F
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and 3G). For shRNA experiments, we typically wait 3 days after transfection to do the migratory

experiment and the corresponding cell lysate for protein assay.

CRITICAL: For imaging and transfection, hGPCs are first cultured on a laminin dish. In fact,

cells survive better after trypsinization than trituration which can lead to massive cell

death. Also, this step allows a better estimation of the cell number upon counting.

Imaging, cell tracking, and measurement of mean speed and persistence

Timing: 2 h

Formigration assays (measure of speed andpersistence), cells seeded onmicropattern lines or grids are

imaged in phase contrast using a 103 objective on a microscope equipped with temperature, humidity

and CO2 control (Figures 4A and 4B). Acquisitions are typically obtained over a period of 12–24 h.

25. Cell seeding on micropatterns:

a. Aspirate the medium from the cells previously seeded on laminin, rinse once with DPBS and

incubate cells with 500 mL of trypsin/EDTA for 1–5 min at 37�C.
b. Resuspend the cells with 3.5 mL of GSC-BSA medium to neutralize the trypsin and centrifuge

at 200 3 g for 5 min at room temperature (20�C–25�C).
c. Aspirate the supernatant and re-suspend the cells in 4 mL of GSC medium.

d. Count 10 mL of cells using a cell counting chamber.

e. Seed 2,000–100,000 cells on the patterned dishes depending on the pattern and the size of

the cells (we seed 2,000 cells on lines and 30,000 cells on grids with our NNI-21 with 1 cm2

patterned area).

f. Incubate at 37�C for 3–4 h, then gently rinse with warmed medium to get rid of the floating

cells before imaging.

Note: The incubation timemay be increased to 24–48 h depending on the cell’s ability to atta-

ch and the type of patterns.

26. Migration assay:

a. Turn on the microscope, camera, CO2 supply, the water pump and the heating unit at least

1 h before use. The heating unit temperature is set to 37�C. Set the 103 phase objective (Fig-

ure 4A).

b. Place the imaging dishes in the plate holder and allow cells to stabilize for at least 30 min

before recording (Figure 4B).

c. Using the software interface, select the positions to record, adjust the focus using the cam-

era, the exposure time, the light power, the time length of the acquisition, and the acquisition

rate, and start imaging.

Note: We use a Leica microscope with the dedicated software Leica Application Suite (LAS).

Any microscope equipped with temperature, CO2 control, 103 phase objective, and an auto-

mated stage can be used. We typically image the cells at 1 image every 6 min for 12–20 h

(overnight). Moreover, if cells were transfected with a fluorescent construct, the user should

acquire the corresponding fluorescent channel to track the transfected cells.

27. Cell tracking (Figure 4C):

a. Open one imaging file with Fiji (Schindelin et al., 2012).

b. In Plugins, go to tracking and manual tracking.

Note: Because glioma cells can move in antiparallel streams, change shapes, and bump

frequently in each other, automated tracking programs cannot be used to determine speed
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Figure 4. hGPC imaging and manual tracking

(A and B) Setup used for time-lapse acquisition.

(C and D) Manual tracking plugin in ImageJ/Fiji and tracks. Bars are 100 mm.

(E) Maximum intensity projection: the images of each slice of the timelapse are overlaid on top of each other with ImageJ: Image>Stack>

Z-project>MAX intensity.

(F) Resulting maximum intensity projection of the temporal stack of hGPCs migrating on the gridded micropattern over 7 h movie. Bar is 100 mm.
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and persistence accurately. Cell bodies are manually tracked using the manual tracking plug-

in of ImageJ/Fiji (Figure 4C). The tracks are then pasted in Excel and calculations are made to

extract the speed and persistence.

c. In the tracking window, hit the button ‘‘Add track’’.

d. Click on the cell to track: after each mouse click, the following image of the temporal stack is

visualized until the last image is reached or the ‘‘End track’’ button is pressed.

e. The track files are then saved and opened in excel for analysis.

Note: We usually track the first 6 hours of the movie, for statistical reasons and to avoid bias,

we track all the cells that are present in the first frame of each movie. The following link gives

detailed indications on how the manual tracking plugin works: https://imagej.nih.gov/ij/

plugins/track/track.html. Moreover, in the case of transfected cells, double check with the

fluorescent channel in order to be sure to track only cells that were successfully transfected.

f. Under ‘‘Image > Stack > Z project > MAX intensity’’ the maximum intensity projection of the

temporal stack can be obtained (Figures 4E and 4F). It is a way to extrapolate qualitative phe-

notypes from motile cells, such as hurdling or gliding (Monzo et al., 2021a).

28. Measurement of speed and persistence:

a. To extrapolate values of mean speed and persistence, we used 2 programs developed in

(Gorelik and Gautreau, 2014) that can be integrated with Microsoft Excel.

b. Open aMicrosoft Excel workbook and activate the Developer tab. For Windows, click ‘‘File’’,

‘‘Options’’, ‘‘Customize Ribbon’’, and flag ‘‘‘Developer’’, then click ‘‘Ok’’. For macOS, click

on ‘‘Excel’’ in the menu bar, ‘‘Preferences’’, ‘‘Ribbon & Toolbar’’, then flag ‘‘Developer’’

and save (Figure 5A).

c. For Windows, select ‘‘Macro Security’’ in the Developer tab. In the window that opens, flag

‘‘Enable all Macros’’ and ‘‘Trust access to the VBA project object model’’. Click ‘‘Ok’’. For ma-

cOS, click on ‘‘Excel’’ in the menu bar, ‘‘Preferences’’, ‘‘Security’’, then flag ‘‘Enable all mac-

ros’’ and ‘‘Trust access to the VBA project object model’’ and save (Figure 5B).

d. Select ‘‘Visual Basic’’ in the Developer tab. The Visual Basic Editor appears.

e. On the top left, click on ‘‘Insert Module’’. A blank window appears (Figure 5C).

f. Go on https://static-content.springer.com/esm/art%3A10.1038%2Fnprot.2014.131/Media

Objects/41596_2014_BFnprot2014131_MOESM399_ESM.txt. Select all the text, copy and

paste it in the blank window. This is the program for mean speed (Figure 5C).

CRITICAL: Make sure to select all the text: use the shortcut ‘‘CTRL-A’’ (Windows) ‘‘com-

mand-A’’ (macOS).

g. Repeat steps e and f with the following links:

i. https://static-content.springer.com/esm/art%3A10.1038%2Fnprot.2014.131/MediaObjects/

41596_2014_BFnprot2014131_MOESM400_ESM.txt. This is the program for cell persistence.

ii. https://static-content.springer.com/esm/art%3A10.1038%2Fnprot.2014.131/MediaObjects/

41596_2014_BFnprot2014131_MOESM394_ESM.txt. This is the program for Plot at origin.

Note: Other programs for further analysis can be downloaded from https://www.nature.

com/articles/nprot.2014.131. In this protocol, we focused on speed, persistence and, plot

at the origin.

h. From the Visual Basic Editor, save the workbook as Excel Macro-Enabled Workbook (.xlsm).

This format includes all the macros that have been pasted so far in the excel file.

i. Make a copy of the .xlsm file just saved: we will paste cell trajectories on the copy and keep

the original as a backup (select the file from the directory and copy-paste).
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Figure 5. From manual tracks to mean speed and persistence calculation

(A–F) visual instructions for mean speed, persistence and plot at origin representation. Error bars are S.D.
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j. From the trajectory file, copy the slice number of the trajectory, the X and Y coordinates and,

paste them respectively in column D (or 4), E (or 5), and F (or 6) of a worksheet of the .xlsm file

just saved (Figure 5D). Numbers must start from 1, have no space between rows, and in-

crease monotonically. When a new trajectory begins, the program will detect the change

from, for instance, 43 to 1. At this step, it automatically generates a new trajectory.

k. Rename the current worksheet (e.g., ‘‘Condition 1’’), and repeat step j in new worksheets if

additional conditions are present. The name of the worksheet is detected from the program

and used in the graphs.

l. From the Developer tab, click on ‘‘Macros.’’ Select one of the installed programs and hit

‘‘Run’’. Results are displayed in a new worksheet (Figure 5E).

m. To plot the data, copy and paste the data in a column tab in GraphPad Prism 9.0 (Figure 5F).

For cell persistence, we focused on the last point: in the Excel workbook, go under the work-

sheet ‘‘LastPoint’’ and copy the data highlighted in Figure 5F.

EXPECTED OUTCOMES

This protocol describes a way to design simple and controlled environments that mimic in vivo

topography and that can be easily manipulated. We have used it to 1) analyze the motility modes

of cells (glioma or other cells) and quantify their speed and persistence; 2) to compare transfected

cells in order to define the role of a given protein in cell motility; 3) to generate high time-resolution

kymographs to carefully describe a given motility mode; 4) to analyze the mechanoproperties of the

cells on specific topographic environments; 5) to analyze the localization and function of molecules

by high-resolution microscopy.

With this protocol of micropatterning, we have compared the motility modes of rat C6 glioma cells

migrating on 2D and laminin strips of various widths (Monzo et al., 2016). We found that when C6

cells were migrating on thin lines (<10 mm), their motility was similar to the one observed in vivo,

on brain blood vessels. They were moving in a 2 phase motion with one phase where cells were elon-

gating in the 2 directions and one phase where the tail retracted (Monzo et al., 2016). Kymographs

from high time-resolution movies (1 image/30 s) could be generated which allowed us to model this

one-dimension type of motility (Ron et al., 2020). TIRF microscopy was used to analyze adhesion dy-

namics during this linear motility (Monzo et al., 2016). Moreover, we also observed antiparallel

streaming when cells reached high density on larger strips which are similar to the currents observed

later on, in neural progenitor cell cultures (Kawaguchi et al., 2017; Monzo et al., 2016). Themotility of

these cells was dependent on actin dynamics, myosin 2 and formins but was independent on Arp2/3

when using the Arp2/3 inhibitor CK666 which blockedmotility on 2D but not on linear tracks. Finally,

we could demonstrate the role of the formin FHOD3 in this linear motility (Monzo et al., 2016).

More recently, we have been able to compare the motility of several patient-derived cell lines on 3

different settings: 2D, grids and lines. We found that grids were the closest decoy to mimic the brain

blood vessels, the most common tracks that these cells use when navigating the brain. Wemeasured

the speed and persistence of these cells and found that the most aggressive cells in the mouse brain

were the fastest and the least persistent on 2D and grid. By using our micropatterned grids we have

been able to describe two types of motility that we named gliding and hurdling (Monzo et al.,

2021a). Gliders were cells that were persistently following the grids while the hurdlers were faster

and ‘jumped’ from one line to another. These behaviors were easily observable by projecting the

stacks of the time-lapses as explained in step 27-f. By manipulating the size of the grids, we could

show that motility behaviors were intrinsic to the cells (Monzo et al., 2021a).

Using this protocol, we also analyzed the motility of other cell lines (cancer of various origin and

normal fibroblast) and sorted them in function of their behavior. Moreover, through the function

‘multiple stage positioning’, we could test multiple drugs at different doses and tested also control

and shRNA transfected cells simultaneously (Monzo et al., 2021a).
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This protocol allowed us to compare the mechanoproperties of our patient-derived cell lines when

migrating on linear tracks. Micropatterning on glass-bottom dishes allowed us to analyze cell adhe-

sion (size, dynamic, number) by TIRF and Fluorescence Recovery After Photobleaching (FRAP). Deep

UV photolithography allowed us to analyze traction forces (Hennig et al., 2020) and to measure cell

stiffness by AFM. We found that the hurdlers displayed adhesions that were larger in size and more

dynamic. These cells were also the stiffest and displayed higher traction forces (Monzo et al., 2021a).

Finally, micropatterning on glass allowed us to analyze the localization and the function of the formin

FMN1 in the hurdler migrating on linear tracks by high resolution microscopy (Monzo et al., 2021a).

QUANTIFICATION AND STATISTICAL ANALYSIS

Statistical analysis can be done using GraphPad Prism 9.0 (Figure 5F). For statistical significance, we

recommend doing t-test or one-way ANOVA test for mean speed. For the directionality ratio, we

performed the Mann-Whitney test.

LIMITATIONS

This protocol provides a quantitative way to evaluate the motility of hGPCs (or other cell lines) on an in

vitro platform. The in vitro platform is a Petri dish (plastic or glass) that is functionalized with a gridded

micropattern. This micropattern aims to reproduce linear tracks while forcing the cells to make a choice

when encountering a junction: either turning 90 degrees or going straight. With this tool, we reproduce

with a reasonable degree of complexity the blood vessel network that glioma cells follow as they invade

the brain (Cuddapah et al., 2014). However, the gridded micropattern is made of a single protein (lam-

inin in our case) deposited as a 7 mm wide stripe onto a �GPa stiff substrate: we created a setup that is

bi-dimensional with no consideration of the three-dimensional confinement of the brain.

In vivo, glioma cells migrate on the abluminal side of the blood vessels that contains laminin but also

collagen IV and collagen V as well as fibronectin in some conditions (Bellail et al., 2004; Bellon et al.,

1985; Charles et al., 2012; Giese and Westphal, 1996; Gladson, 1999; Knott et al., 1998; McComb

and Bigner, 1985; Paulus et al., 1988). These substrates are not taken into account in our experi-

mental setup since we have found that laminin only potentiated the motility of our glioma cells

(Monzo et al., 2016, 2021a).

Moreover, by using stripes on plastic or glass, we do not reproduce the curved topography of the

blood vessels. Other biophysical tools can take into account the tubular geometry of the blood ves-

sels, such as electrospun nanofibers (Guetta-Terrier et al., 2015) (Monzo et al., 2021b) and brain slice

assays (Polleux and Ghosh, 2002) that, however, lack controllability. In Monzo et al. (2021a), we uti-

lized these 2 methodologies as an approach to complement what we observed on the gridded mi-

cropatterns. We exploited electrospun fibers to study the motility of the cell lines NNI-11, NNI-21,

NNI-24, and the brain slice assay to validate the impact of the formin FMN1 on the invasion of NNI-

21 (Monzo et al., 2021a).

Finally, our experimental setup does not take into account the mechanical confinement imposed by

the brain, or its dimensionality. While migrating on the gridded micropattern, cells are laterally

confined but the third dimension is not considered. Alternative approaches such as cellular embed-

ding in soft hydrogels or brain slice assays are a closer mimicry of the mechanical confinement that

the cells experience in vivo. In these cases, the environmental stiffness is in the same order of magni-

tude (from few to tens kilopascals, depending on the cross-linking) as the native one (the brain

young’s modulus ranges from several hundred pascals to several kilopascals) (Elkin et al., 2007;

Franze, 2013; Hrapko et al., 2008).

TROUBLESHOOTING

Problem 1

Unmolding PDMS from the silicon wafer destroys the master (step 13 in ‘‘before you begin’’).
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Potential solution

Most likely the silanization procedure of the wafer has failed. To overcome this, check that the silane

is still functional by repeating the procedure on a new wafer. When curing a drop of PDMS on a

corner of the silicon wafer, polymerized PDMS should peel off easily. Otherwise, the silane solution

has been oxidized and should be replaced with a new one. Alternatively, PDMS might have been

cured in the oven too long. Curing for more than 2 h at 70 C might trigger the binding of the

PDMS to the wafer (Théry and Piel, 2009).

Problem 2

Laminin solution does not spread as a flat layer on the bacterial dish (step 15 in ‘‘before you begin’’).

Potential solution

Increasing the volume of DPBS (and thus the volume of laminin) will ease the covering of the surface

(step 15 in ‘‘before you begin’’).

Problem 3

hGPCs adhere to the cell culture plate despite being cultured in non-adherent conditions (step 9).

Potential solution

This is dependent on the cell line. One of our cell lines (NNI-24) tends to attach to the dish at the

beginning of the culture and grow more slowly than the others. After 5 days of culture, spheres

are small and attached to the dish. In this case, we just add 80 mL of B27 mix to the dish and wait

another 5 days of culture. In general, after 5 days, spheres have detached and are ready for

trituration.

Problem 4

Micro-contact printing didn’t work and cells do not adhere or adhere but no pattern is observable

(step 25f).

Potential solution

It means either that not enough pressure was applied to the stamp, or that the coating of the PDMS

dried out before blowing it off. We recommend applying pressure uniformly with tweezers and not

letting the PDMS dry out. On the other hand, applying an exaggerated pressure causes sagging in

the PDMS and thus the whole stamp adheres to the substrate. This will result in the deposition of

proteins outside of the PDMS features. Moreover, the stamp must not be moved while leaning.

The whole procedure has to be carried out with precision and requires the least unwanted move-

ment during PDMS handling. We recommend mixing fluorescent BSA with the laminin to be able

to visualize the pattern after stamping.

Problem 5

The exported .csv file containing the tracks shows ‘‘C1’’, ‘‘C2’’, etc. headings instead of ‘‘X’’, ‘‘Y’’, ‘‘Ve-

locity’’, etc. (step 27e).

Potential solution

This is most likely due to a bug in the manual tracking software. To avoid this, we recommend hitting

‘‘Delete all tracks’’ and closing the result tab after saving. In any case, if such an error occurs, the re-

sults can be used and headings can be manually replaced by copy-paste from an uncorrupted file.

Problem 6

When Excel recognizes numbers as strings, they are adjusted to the left-hand side in each cell,

instead of the right-hand side. This happens with decimal numbers (step 28c).
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Potential solution

To overcome this, the user must change the decimal separator in the system settings and use the dot. In

Windows, go under ‘‘Excel options > Advanced > Editing options > Use system separators’’ and replace

it with the dot. In MacOS, select ‘‘System Preferences’’ in the status bar, then ‘‘Language &

region > Advanced’’ and select the dot as a decimal separator. Alternatively, one can use the ‘‘find

and replace’’ function in Excel (Control +H) and replace commaswith dots (or vice-versa) in theExcel file.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Pascale Monzo (pascale.monzo@ifom.eu).

Materials availability

This study did not generate new unique reagents.

Data and code availability

Raw data are available upon request from the lead contact, Pascale Monzo (pascale.monzo@ifom.

eu). The codes utilized in this protocol are published and available at https://www.nature.com/

articles/nprot.2014.131#Sec28.
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